
• NIM056875 - Different ways of moving the same network features to the same location give different results.

• NIM057360 - Event layers created from Excel tables that have been joined cannot be exported to shapefile or feature class format, causing a crash 
(ver 9x) or several error messages (ver 10).

• NIM056468 - 'Replace All with Prereconcile Version' causes geometric network service lines to be shifted.

• NIM053647 - Combinatorial tools produces incorrect field name when input is not an ESRI Grid.

• NIM054930 - Make Grids and Gratiules Layer: Cannot run tool in the background if it requires adding symbols to existing representation classes.

• NIM058602 - <l10n> The word 'empty' should be localized in the data source item description.

• NIM058627 - The GP tools freeze if the user attempts to write new feature class to feature dataset with a lot of Relationship classes in it.

• NIM058512 - Creating a search cursor fails when using spatial reference with custom domain when the map document is in page layout.

• NIM057451 - Allow orphan junctions to subsume orphan junctions during editing and reconcile.

• NIM057574 - Subsuming an orphan junction with a user defined junction in the Edit version may result in loss of newly inserted edges connected to 
the orphan junction in the parent version following reconcile in favor of the Edit version.

• NIM052617 - User would like the Snap Raster option to be honored by the Tin to Raster (gp) tool.

• NIM040605 - When performing a join on an open Excel table in ArcMap, the table does not refresh. Instead you will see empty fields and very small 
column widths.

• NIM040904 - The Fill tool returns error codes 010005 and 010067 when executed on a large raster dataset.

• NIM000991 - Enhanc: Provide option to export domain codes or descriptions when exporting from geodatabase

• NIM000239 - The order of annotation classes in the table of contents is different when opening and closing MXD.

• NIM049908 - Cannot drag and drop a layer from ArcMap into ArcGlobe.

• NIM051041 - Adding an annotation feature to a new Annotation Class causes incorrect rotation when the data frame is rotated.

• NIM049615 - MaintainSpatialIndex = TRUE is broken. Re-creates the spatial index once for every input rather than leaving the existing spatial index 
in place.

• NIM043466 - When aborting on conflicts, the reconciling process leaves a shared lock on the target version.

• NIM047627 - During the first import of schema changes, a new Domain assignment to a field will not carry to the child Geodatabase.

• NIM059249 - ArcMap crashes in an edit session when clicking the layer name in the Attributes window.

• NIM059295 - <l10n> Check marks and icons in the 'Create new template' wizard are mirrored.

• NIM059155 - Exporting a map with a rotated raster layer to PDF contains white spaces.

• NIM058800 - 'ExportToTIFF' function does not write GeoTIFF tags when 'geoTIFF_tags' parameter is set to 'True'.

• NIM058851 - <I18N> Alternating Scale Bar fills in solid black when zooming in.

• NIM058760 - Implement default locators using URL resource for specifying the list of locators.

• NIM058666 - ArcPy saveACopy method fails when saving to the previous version.

• NIM058744 - ArcGIS Server does not create elevation cache tiles between Face T4 and T2 along the 45Â°N latitude.

• NIM059092 - Editing an existing feature within an Edit session does not allow for the added segment to be included in the existing feature's attribute 
record.

• NIM059102 - Some NITFs with World files (.nfw) hang ArcMap when opened.

• NIM059069 - If archiving is enabled to track changes with 1-way replicas, re-exporting unacknowledged messages fails.

• NIM058951 - FD:  ArcMap and ArcCatalog crash when trying to open a particular DGN V8 file.

• NIM059051 - Cannot delete fields from shapefiles in ArcMap 10 on Windows 7 or Windows 2008 via the table view; works fine on Windows XP, 
Windows 2003, and Windows Vista.

ArcGIS Desktop (382)

Last Updated 03/24/11 - ArcGIS 10.0 Service Pack 2 is planned to be available in Late April/Early May, 2011. SP2 includes 
many fixes since the release, the targeted issues are listed below.

Esri will be updating this list periodically with additions and other changes. If you have any feedback or questions regarding 
this list please post in the appropriate technology forum located at:

http://forums.arcgis.com

NOTE: The following list is subject to change. Esri recommends proper evaluation of the fixes before applying a 
Service Pack.

Esri staff will be monitoring these forums and respond to your feedback.

If you have additional enhancements or ideas that you would like to see included in future service packs or releases, please 
post them on the ArcGIS Ideas site:

http://ideas.arcgis.com

http://forums.arcgis.com/
http://ideas.arcgis.com/


• NIM060861 - In ArcGIS Desktop 10, repairing a data source on a programmatically created feature layer results into an error.

• NIM060831 - The legend of a KMZ file created in ArcGIS 10 using the Map to KML tool shows blank in Google Earth.

• NIM060816 - Raster catalog display order by option does not work for some raster data.

• NIM060918 - When editing in multiple ArcMap Sessions, Label Feature disappears when Map extents are zoomed to a newly created feature in 
subsequent ArcMap Sessions.

• NIM060880 -  When trying to open certain CCITT group 4 compressed 1-bit single-band TIFF images, an invalid raster dataset error is returned.

• NIM060879 - Synchronization fails with an error when the edits are across a spatial filter that involves a many to many relationship class in two-way 
replicas.

• NIM060810 - Problem editing z-enabled feature classes that participate in a geometric network in ArcGIS 10.

• NIM060734 - Mosaic dataset renders incorrectly in Web applications when published as an image service.

• NIM060711 - Performance is slow in 10 geodatabase compared to 9.3.1 observed during comparison of changes in different versions.

• NIM060642 - Secured WCS Service cannot be previewed in ArcCatalog and cannot be added in ArcMap.

• NIM060790 - The Field Calculator overrides the expression if the expression contains the field name string.

• NIM060778 - Maps exported to EPS in CMYK colorspace convert CMYK values to RGB values for labels/anno if character marker symbols are used 
in text symbol.

• NIM060759 - Rasters with tag AREA_OR_POINT are incorrectly lining up in ArcGIS Desktop that did not at previous releases.

• NIM061295 - Boundary Clean tool fails to execute with a multiband raster.

• NIM061259 - KML to Layer should enable time automatically when the input KML supports time.

• NIM061177 - Multipart annotation with characters > 255 result in incorrect characters when exported to PDF, even with embedded fonts.

• NIM061306 - Cannot edit 'Supplemental Information' in FGDC Metadata in ArcGIS 10.

• NIM061168 - Requesting for configuring metadata style sheet location

• NIM061009 - <i18n> Selection chip in the editing session is not opened in RTL environment.

• NIM060923 - TIFF images do not fall in the correct location as the False_Northing is read incorrectly.

• NIM060922 - Layer.replaceDataSource is extremely slow when run on SDE datasources.

• NIM061094 - The Find tool does not work with a decimal point or a single quote.

• NIM061065 - Projection on the fly in ArcMap is ten times slower in the file geodatabase and ArcSDE than with shapefiles and personal geodatabase.

• NIM061049 - Copy/Paste shortcuts Ctrl + c and Ctrl + v fails to work on selected records in ArcGIS 10.

• NIM060613 - In ModelBuilder, adding a raster layer to the Extract Multi Values to Points as input raster crashes ArcMap.

• NIM060012 - The ArcScene and ArcGlobe cannot import symbol from another layer using the Import Symbology dialog.

• NIM059976 - Scale and Rotation is not calculated during the Topo importer process.

• NIM059845 - Geometry objects lack appropriate precision.

• NIM060238 - ECW is temporarily shown as invalid dataset.

• NIM060183 - Initial extent of map service changes after call to export map.

• NIM060018 - In a mosaic dataset, the Extract by Mask tool does not honor the query conducted using the Make Mosaic Layer tool.

• NIM059832 - Polygon to raster is outputting strange results when converting a feature class with complex edges that are in 
'NAD_1983_HARN_WISCRS_Brown_County_Feet'.

• NIM059437 - Cannot generate driving directions on network data created by dissolving a network dataset that had alternate street names.

• NIM059436 - Programmatically panning a map with dynamic map service in a .NET timer event results in an error.

• NIM059317 - Synch_send versions are created and orphaned after creating a one way parent to child replica on archived data, with the option 
checked to 'use archiving to track changes for 1 way replication'.

• NIM059824 - XY Event Source layer labels disappear when new points are located outside of the existing extent window.

• NIM059791 -  A custom Table of Content view created using the Esri sample code  'Layer filtering TOC view' does not refresh when the custom 
Table of Content view opens as the mouse hovers over the Table of Contents tab. Clicking on the content area of the view refreshes it.

• NIM059506 - In multipage PDF exports, random line segments in a line feature class symbolized with cartographic representations increase in size 
or become miscolored.

• NIM060421 - Control points that were previously associated cannot be joined to after a parcel using that point has been unjoined.

• NIM060411 - Two representation styles with numerous marker points draw much slower than a comparable standard symbology style.

• NIM060395 - Ignore VCS speciifed on append, reports DATUM mismatch.

• NIM060603 - When 'Mosaic dataset Tutorial Exercise 7' is performed on Windows 7 operating system in background mode, ArcGIS throws an error.

• NIM060503 - Consolidation and packaging tools create a commondata folder in the output even though no data is being preserved.

• NIM060496 - Line labels do not appear on the line while zoomed out when there is a reference scale set on the Data Frame and the feature class 
option 'Scale symbols when a reference scale is set' is unchecked.

• NIM060390 - Using the Merge Two Points tool and Merge Points wtihin Rectangle tool creates vectors that results in undesirable feature class 
adjustment outcomes.

• NIM060298 - Renaming an .img file with an .ige file causes the source raster to not display in ArcGIS 10.

• NIM060285 - In Solaris, CreateObject fails for NetCDFileProperties.

• NIM060275 - <L10N> There is a hard coded string in Coordinate dialog box.

• NIM060389 - When creating a schema-only layer package that includes a Parcel Fabric and a .lyr file (build from a sub-class), the .lyr file has a 
broken data source when un-packed.

• NIM060385 - Selection on Control does not fill in the control dialog box.

• NIM060328 - Provide ability to create custom data source with ArcGIS 10.0.



• NIM062534 - Tabulate Area runs without completion when the processing cell size is set to a smaller value than the default.

• NIM062527 - Planarize on parallel offset does not break line if the offset line is perpendicular to parent line.

• NIM062331 - The "level" field is not being used when Export to a DGN Version 8 file.  If level values are defined they are not being created in the 
output DGN file.

• NIM062516 - 9.3.1 Representation Rules with dash geometric effects are changed when upgrading to version 10.

• NIM062267 - Creating an Add-in using ITableWindow3 to get reference to Active table window crashes ArcMap.

• NIM061713 - There is a syntax error in the SMTP server authentication portion of the SendEmailWithZip.py script provided in the Server Tools > 
Data Extraction toolset.

• NIM061730 - ArcMap Drawing Errors when labeling an X,Y event layer created from a table in an ArcSDE geodatabase not registered with the 
geodatabase.

• NIM061708 - Unable to set the margin size at the Data Driven Page in a bi-directional environment.

• NIM061656 - Concurrent editing of Parcel Fabric within separate child versions of Default hangs other edit sessions when the Modify command is 
used.

• NIM061662 - Cannot Copy/Paste a network dataset with multiple turn feature sources

• NIM061748 - Single value output generated for the combine tool in ArcGIS 10.

• NIM061802 - Simplify Polygon tool is not populating point output for collapsed features when the 'No Check' option is used with a minimum size 
value.

• NIM061747 - Using a geodatabase from previous version in the Topo to Raster tool creates errors.

• NIM061743 - ArcMap creates thousands of default.gdb files on startup and eventually fails to start. (This seems related to MSXML 4.0.)

• NIM061746 - With 10.0 geodatabases, permissions are not correctly applied to geometric network weight tables preventing users granted 
permissions from opening the geometric network.

• NIM061608 - The Terrain to Raster tool generates tiffs that are rendered incorrectly when viewed from a 9.3.1 ArcMap client.

• NIM061362 - ListBrokenDataSources does not list broken annotation layers.

• NIM061385 - Swedish regional and language settings cause "failed to generate directions" error when using ArcGIS 10 Network Analyst.

• NIM061351 - Metadata fails to save URL (linkages) that are in uppercase.

• NIM061308 - Commas are removed in a float field when creating reports in German regional settings.

• NIM061350 - ICommandItem.Style property does not work in 10.0.

• NIM061543 - Right-clicking on multiple selected pictures and selecting 'properties' from the context menu crashes ArcMap.

• NIM061557 - Using Extract Values to Points tool in spatial analyst toolbox, when the output is set to be a personal geodatabase, two error messages 
come out and the tool cannot be executed.

• NIM061516 - Extent rectangles with leader lines set at certain scales points horizontally and crashes ArcMap, which then corrupts the map 
document.

• NIM061445 - In some sessions, after running a GP tool, ArcMap moves behind other Windows applications.

• NIM061452 - Spatial reference along with the units is not read correctly for TIFF images.

• NIM062084 - GP tools in the Data Management Tools > Raster > Mosaic Dataset toolset configured to run as services fail with the error "Error 
000824 : The tool is not licensed" under the ArcGIS Server standard license level.

• NIM062132 - Create Report wizard does not open due to certain system settings or font availabilities.

• NIM062067 - A legend title with certain characters that has formatting set to Bold, Underline, and Arial font has a shorter underline when exported as 
a PDF.

• NIM062020 - The context menu for the rectangle construction tool is greyed out if it is ArcView 10 users.

• NIM062024 - After exporting to PDF from a DDP enabled map, deselection of elements is not working as it should.

• NIM062228 - Rebuild connectivity during a replica sync leaves some features disconnected in some ArcFM specific workflows.

• NIM062255 - The cursor for 'Sketch tool' in the editor toolbar does not function properly when invoked programmatically.

• NIM062206 - <L10N> The ArcMap Options dialog box name is concatenated and cannot be translated properly.

• NIM062158 - <L10N> The ArcGlobe Options dialog box name is concatenated from two separate strings and cannot be translated properly.

• NIM062179 - Eliminate Polygon Part tool crashes with certain parameter settings.

• NIM061998 - Concurrent editing of Parcel Fabric within separate child versions of Default hangs other edit sessions when the Modify command is 
used.

• NIM061823 - Custom MapSurroundFrame crashes ArcMap in 10 but works in 9.3.1

• NIM061873 - IModelName.ModelName is blank for 10.0 gdbs when accessed using Name objects.

• NIM061822 - Export to CAD does not honor the "Circle" field value for the CadType field which is used with Export to CAD.

• NIM061803 - IRendererIdentify::Identify is not returning values for symbols that are offset from their base geometry by geometric effects or property 
overrides.

• NIM061811 - Incorrect arrows direction in the Data Driven Page.

• NIM061933 - Multi-ring Buffer tool clips output buffers if Dissolve: All is specified.

• NIM061964 - Incorrect location for marker graphics are generated when converting it to MGRS.

• NIM061932 - Reflection with an affine transformation doesn’t work correctly with data frame rotation.

• NIM061884 - When using the Editor's Trace Tool to create a new network edge feature the "Multipart feature geometries not supported” error is 
raised while tracing an edge feature which contains a true curve.

• NIM061927 - Registry key settings for Representation Field Override Units need to be handled properly by API when calls are made directly against 
the GDB.



• NIM063177 - Remove button on a previously created job is broken.

• NIM063176 - Blow out circular curve created for a donut parcel.

• NIM063175 - Unjoined Parcel Groups need to persist expanded or condensed in Parcel Explorer.

• NIM063178 - Parcel Explorer window disabled. Can not recover unless ArcMap is restarted.

• NIM063186 - Parcel Remainder does not work on a parcel participating in a separate layer file if it is queried out of the default Parcels layer.

• NIM063185 - Parcel polygon not in sync with parcel line-work after linepoint cracking has been performed.

• NIM063180 - Deleting a Control Point should remove its association to the Name field on its formerly associated point.

• NIM063159 - Import ArcEngine doesn't set the 'engine' product which causing the script to run with the highest available license.

• NIM062989 - Using the Statistics Field parameter with a "MIN" or "MAX" keyword with a Long Integer or Short Integer caused a crash.

• NIM062987 - Map rendering problem when moving overlying windows.

• NIM062964 - Pick outputs incorrect results to non-grids because of pixel depth prediction error.

• NIM063043 - Merge tool cannot use in-line variable substitution in ModelBuilder for path to output dataset.

• NIM063158 - Setting the default attribute value in the Feature Template properties does not result in the creation of a Feature Template.

• NIM063134 - Flags and barriers should not be placed on network features excluded by the Definition Query

• NIM063129 - Cannot generate driving directions on network dataset created by dissolving a network dataset that has new street name field settings.

• NIM063189 - ArcMap crashes when using the Make Feature Layer GP tool on a parcel fabric sublayer.

• NIM063188 - Set plan on Merge causes tool to not work.

• NIM063187 - Crash when deleting join links.

• NIM063190 - Import of unclosed parcels results in missing data.

• NIM063195 - Cannot change the plan during a construction.

• NIM063193 - Curve with 180 degree delta needs a better error message.

• NIM063192 - No map refresh when zoom to extent of parcel.

• NIM062716 - It isn't possible to create metadata for Web services that complies with the North American Profile.

• NIM062715 - Geoprocessing history content is kept separate from lineage information, and is not available to be included in the documented lineage 
of a dataset.

• NIM062713 - Clear selection command in attribute table crashes ArcMap.

• NIM062772 - Feature classes projected from Alaska State Plane 5 to Cube will not display in ArcGlobe when rasterized. Rasters projected from 
Alaska State Plane 5 to Cube do not display properly.

• NIM062842 - Load object command crashes ArcMap in Service Pack 1.

• NIM062789 - All dialogs should obey field visibility and use field aliases.

• NIM062788 - Topology loader fails to load certain parcels, incorrectly defining them as multi-part.

• NIM062691 - Remove extent information from Service Details page.

• NIM062577 - When running Mean center on data with all negative values for a particular case, the tool fails.

• NIM062576 - Coefficient surfaces are not correct.

• NIM062571 - If FGDC metadata hasn't been upgraded and it has elements corresponding to the item description that contain the & or < characters, 
the metadata can't be displayed.

• NIM062580 - Ripleys K fails with the Reduce or Ripley Correction methods if user-provided parameter values produce an empty study area polygon.  
The error message given isn't helpful.

• NIM062690 - On Resource Details page, text typed into Processing Environment won't save.

• NIM062611 - Surface Contour will return, "Error 050079: The index interval must be evenly divisible by the contour interval." when the Contour 
Interval is set to 0.2 and an Index Interval is set even when the Index Interval can be evenly divisible by the 0.2.

• NIM062587 - INetworkTopology::GetAdjacentEdgeCount can return random number if its parameter EID is 0.

• NIM062928 - Zonal Statistics tool UI does not correctly filter data types and statistics type when input is a floating point mosaic dataset.

• NIM062927 - Cutfill - arcpy way in a loop crashes when scratch WS is set to fGDB (not using save and crash on 2nd iteration).

• NIM062926 - <Linux> Zonal Stats is crashing with shape input and string field.

• NIM062929 - Resampling non-grids with pyramids gives incorrect results.

• NIM062963 - Flow length fails to execute on Linux.

• NIM062951 - KML to Layer needs to put a default value for folder output.

• NIM062931 - FeatureToRaster (polygon input) crashes when Cancel button is hit.

• NIM062925 - ObserverPoint creates incorrect output when the output format is pgdb or img.

• NIM062864 - Origin Connection sequenced incorrectly.

• NIM062863 - Redraw performance is slow with representations when zooming in on polygons with numerous donut holes.

• NIM062848 - ArcGIS Online operations (Sign In.., Add Basemap..., ArcGIS Online, Search) fail to provide pass-through authentication credentials to 
proxy servers.

• NIM062875 - An error saying 'Turn element already exists.' occurs when rebuilding a network dataset with existing turns that have been edited.

• NIM062924 - Weighted overlay scale values change when UI is refreshed in ModelBuilder. Happens only when tabbing through overlay table.

• NIM062920 - Extract Multi Values to Points : Reports erroneous values in the table.

• NIM062905 - Many Spatial Analyst and raster geoprocessing tools stored in models within version 10 toolboxes cause the model to disappear once 
saved to version 9.3.



• NIM063656 - ArcMap application crashes when the GDI objects in the Task Manager increase more then 10,000 for the ArcMap process

• NIM063687 - Getting error 010067 when running Iso Cluster tool.

• NIM063629 - DBMS Error when merging points on SDE database.

• NIM063601 - Memory leak in GpRasterFuncBase::DialogStartup.

• NIM063604 - Fix memory leak in ZonalGeometryAsTable.

• NIM063710 - "Append" tools failed on versioned data on non-default version in ArcMAP.

• NIM063599 - Spatial Analyst tools with an input raster selection leaks memory.

• NIM063273 - Iso Cluster Unsupervised Classification : The unsupervised classification script tool generates an error message on Linux with given 
test case and data.

• NIM063275 - Divide, Plus, etc. tools truncate floating-point constant to integer if the constant is like "100.0".

• NIM063272 - On the Lineage page in the ArcGIS metadata editor, a red X isn't available to let you remove a process step from the metadata.

• NIM063269 - Local functions do not accept NetCDF raster layer or raster layer made by MakeRasterLayer tool as input.

• NIM063270 - Math tools create incorrect output when inputs contain NetCDF raster layer.

• NIM063289 - Looping through the Graphics Container (PageLayout) for TextElements does not recognize the correct number of elements in the 
graphics container with the presence of a MessageBox within the search loop.

• NIM063297 - Raster statistics properties cannot be queried from temporary grid rasters.

• NIM063278 - Rank tool creates incorrect results in non-grid output because of a pixel-type predication error.

• NIM063276 - An empty long or double variable cannot be connected to math tools using the Connect tool in ModelBuilder.

• NIM063277 - Strange error messages for ExtractByAttribute, Con, Test  tools when whereClause contains a syntax error (for floating-point input 
only).

• NIM063253 - SharePackage tool when run from Python does not add the package to the ArcGIS Online group.

• NIM063254 - DensifySamplingNetwork - sometimes produces different results even though the random number generator seed is set to 1.

• NIM063208 - Unable to edit the Data Quality portion of metadata in the ArcCatalog metadata editor.

• NIM063196 - Copy and paste CAD lines results in construction lines being mangled.

• NIM063197 - Unjoined, unclosed parcel's line segments are reversed.

• NIM063267 - Arcpy local functions perform slower than SOMA when the input grid is integer type.

• NIM063268 - Block size is ignored by tools in arcpy when output is in FGDB.

• NIM063258 - Detect Graphic Conflict tool is producing unexpected output for linear features which form closed loops and/or self overlap.

• NIM063256 - Single band from a multiband raster as input causes the Wizard to crash.

• NIM063257 - <I18N> PolygonToRaster - output cellsize and extent values do not have decimal values in comma locale when input cell size has 
decimals (only with grid output and only reproduciable in 10).

• NIM063571 - Tabulate Area geoprocessing tool outputs incorrect results when a string field is used for the Zone field.

• NIM063588 - Need to handle reclassification of floating point data that falls outside of the remap range. Output is integer raster.

• NIM063567 - Particle Track geoprocessing tool when output is to fgdb has two extra id fields in the attribute table.

• NIM063563 - Export to CAD an Annotation feature class to DWG versions (r2004, r2004, r2000, r14) causes the application to crash.  Version 2007
and Versions 2010 run fine.

Export to CAD crashes with "Serious Application Error" when exporting GDB or MDB annotation feature class to AutoCAD r2004, r2004, r2000, r14.
Export to r2007 or r2010 works.

• NIM063566 - The Raster Calculator geoprocessing tool, when outputting to a grid scratch workspace, breaks layers to previous results from the 
Raster Calculator.

• NIM063595 - In scripting, saving a multiband raster with one only band (principal components)  renames the temporary raster container but not the 
associated  raster band and subsequent expressions fail to execute.

• NIM063596 - Viewshed leaks memory.

• NIM063593 - ArcGIS crashes when viewing feature classes in specific ArcSDE for Oracle geodatabase following successful upgrade to ArcSDE 
10.0.

• NIM063589 - WeightedOverlay does not compute sum of influences correctly.  Fails with error on Linux, passes on Solaris.

• NIM063591 - When a temp fgdb raster is saved from the Python window and added into the TOC, the layer is incorrect.

• NIM063329 - Parcels not being loaded via Topoloader if there are small line segements that fall within a tolerance.

• NIM063361 - Importing a GDB XML workspace document (schema only) fails to persist a domain assignment to a Fabric field.

• NIM063324 - Raster to Feature and Contour tools are creating a .CPG file when output is sent to shapefile.

• NIM063298 - The Zonal Histogram tool crashes on Linux when graph name is supplied; it should provide an error.

• NIM063299 - Standard deviation for integer grid outputs uses ‘n’ instead of ‘n-1’ in many cases.

• NIM063552 - Splitting a custom feature with relationship class may fail if the custom feature overrides the default split behavior and if the relationship 
notification has been turned on.

• NIM063561 - Output Format ellipsis button in Report Designer is specified in the GIS Tutorial 1 book but is not present in ArcMap when creating 
reports.

• NIM063549 - Topo to Raster tool performance is slow in ArcGIS 10 as compared to 9.3.1.

• NIM063431 - Tracking license should not be consumed when starting ArcMap, in addition to the ArcInfo license.

• NIM063457 - Mechanism required to disable/enable the display of selectable state with the Representation Select and Direct Select tools.



• NIM064240 - Enhance image service to support background transparency.

• NIM064214 - Maximum Likelihood Classification tool fails in a script tool on Linux with given test case.

• NIM064208 - Mask environment is not honored in Python when a raster object is used in AppyEnvironment.

• NIM064241 - ArcMap crashes when you use the Ellipse tool on the Raster Painting toolbar.

• NIM064291 - Cannot generate driving directions when using the Arabic regional and language setting.

• NIM064289 - The Compare Replica Schema tool fails with an out of memory error for a specific feature dataset when the child replica is a personal 
or file geodatabase.

• NIM064252 - The Add Rule To Topology and Remove Rule From Topology tools need entries for new rules added at ArcGIS 10.

• NIM064112 - Using Copy Parallel on a Vertical line crashes ArcScene and ArcMap.

• NIM064110 - The Create features and attributes window splitter control is not working properly when the Hebrew (bi-di) language resource files are 
being used.

• NIM064101 - When symbolized with UniversCom-55Oblique.ttf, multipart annotations with more than 255 characters add an additional glyph, 
Unicode 63743, to the end of the first text string when exported to EPS.

• NIM064120 - Composite locators with more than 20 locators fail to batch geocode when published to ArcGIS Server.

• NIM064178 - One override point is missing when this particular network dataset is dissolved.

• NIM064155 - Rename mosaic dataset then create fras_* table; the table names are still associated with the old mosaic dataset name.

• NIM064142 - Need to define esp value as double instead of the default int in SIGClassDistance.

• NIM064292 - Using an output coordinate system appears to work, but the calculated search threshold is interpreted in the input coordinate system 
units.

• NIM064319 -  In the German regional setting, 'aux.xml' written in the English regional setting cannot be read properly.

• NIM064313 - Using the editing tool for a vertex and dragging an element crashes ArcMap.

• NIM064293 - Please return, as a derived output, the SOURCE_ID field name to simplify joining field input feature class attributes to output feature 
class results.

• NIM064098 - Layer To KML tool crashes with specific dataset.

• NIM063920 - Mosaic Operator Blend still generates sharp edges.

• NIM063917 - GRID image that has 16-bit color index in the attribute table cannot be rendered correctly with UV renderer.

• NIM063863 - When indexing a folder in the Index/Search Options this error is returned: “The type initializer for ‘Lucene.Net.Store.FSDirectory’ threw 
an exception.”  Also, the Search Window will not find any results.

• NIM063921 - Compute statistics crash with different parameter.

• NIM063936 - Annotation templates are displayed when source layer/subclass is scale surpressed.

• NIM063926 - Create file format referenced mosaic dataset failed with error.

• NIM063922 - <I18N> Interpolation search neighborhood in a script should be locale independent.

• NIM063742 - Windows Java Server SP1: Search Service - SOC processes are crashing when trying to index data.

• NIM063733 - Get correct cell size for environment parameter from a raster with rectangular cell.

• NIM063729 - There may be a performance hit when using the Rebuild Connectivity tool with geometric networks that have feature classes with 
extremely large feature class extents.

• NIM063754 - [Linux] Batch geocoding via SOAP fails in ArcGIS Server for Java on Red Hat Linux 4.5 64-bit after a few batches have been 
processed.

• NIM063853 - Aggregate Points tool is not creating the derived output table.

• NIM063852 - The service pack information does not appear in the Help > About box.

• NIM063797 - “The item's XML contains errors” displayed in ArcCatalog Description Tab  when viewing .xml metadata generated using XSLT 
Transformation Tool and using the “generate metadata template.xslt” as Input XSLT Transformation Tool.

• NIM063937 - VRP solver has very slow solve times (building routes) in ArcLogistics when soft zones are implemented.

• NIM064032 - The 'Properties' and 'New Template' commands on the toolbar in the Organize templates dialog open their appropriate dialogs every 
time they are clicked.

• NIM064020 - Along Line marker placement style for Representations is not equivalent when published to MSD.

• NIM064015 - Representation layer is issuing extra queries for maximum size values.

• NIM064034 - get_ExteriorRingCount incorrect for single part incorrectly oriented polygons.

• NIM064076 - Date fields in reports generated with ArcGIS Desktop 10 display as null values when the date format is dd/mm/yyyy and the value for 
dd is greater than 12.

• NIM064058 - Mosaic datasets with a function on top break after copy and pasting to a different location.

• NIM064043 - Using the Field Calculator to execute a Python codeblock to calculate sequential numbers on a selected set of features in a 
geodatabase feature class only calculates sequential values in groups of 250 features.  After each group of 250 features the sequential numbering 
starts over again.

• NIM063949 - Locator build for nationwide data can fail (the app disappears) when memory conditions are not favorable.

• NIM063948 - Progress indicator does not show progress while copying a locator.

• NIM063938 - PointToRaster fails to execute if input is integer and MEAN Cell Assignment type is selected.

• NIM063950 - Repairing locators does not work.

• NIM063992 - When the flag/barrier cannot be placed because the underlying element is corrupt, the error message should be shown in a message 
box.

• NIM063968 - Random crashes occurring in iterative scripts when using SA tools when changing cell size.

• NIM063962 - When a model output is pathed to the In_Memory workspace, the output is incorrect.



• NIM064523 - Crash on getting the value from a parameter.

• NIM064532 - Need to remove ArcSDE connection and local storage information information from an item's metadata.

• NIM064512 - Update analysis cellsize control when input raster is mosaic data.

• NIM064516 - Geodatabase domain property page does not refresh if a created domain tool is running in the background on a workspace that has a 
feature class participating in the map.

• NIM064535 - Service overview generation fails. "One or more participating rasters under this overview image could not be loaded." "Failed because 
of out of memory ERROR 999999: Error executing function."

• NIM064546 - The Create Report Wizard does not appear when the command is clicked.

• NIM064551 - Run MultipleRingBuffer as a geoprocessing service crashes the server objects due to imtermediate output not set up correctly in the 
script.

• NIM064536 - Line-strings get "flattened" on update.

• NIM064537 - Diagram extent is not stored after diagram migration from ArcGIS 9.3 to ArcGIS 10.0. Diagram extent is not copied during the diagram 
copy.

• NIM064508 - Unable to remove a watermark from a report after it has been added.

• NIM064371 - When using an integer raster with a float field, the output has incorrect values

• NIM064389 - Improve performance of the VRP solver for school bus routing.

• NIM064358 - Table based raster types fail to load records into the mosaic dataset if images do not exist and if they are defined in the RPDef.

• NIM064370 - ArcMap crashes if the mouse wheel is rolled to zoom while in the middle of a trace.

• NIM064390 - Enable selection chip for Parcel Edit tool.

• NIM064415 - There is a containers and update issue with a certain dataset.

• NIM064416 - Node on link does not display correctly when using the AbsolutePosition attribute.

• NIM064392 - When the map has complex symbols, the List By Selection view of the Table Of Contents leaks objects when selecting features in the 
map.

• NIM064395 - Port Performance Improvement to 10.0 SP2.

• NIM064340 - The Reverse Geocode geoprocessing tool copies original shapes into the result, instead of producing reverse geocoded locations, 
when Z/M awareness of the source feature class is different from the the locator's feature class.

• NIM064327 - Grids and Graticules Designer: Restore Decimal point in Decimal Degrees annotations style.

• NIM064328 - Make Grids and Graticules Layer: Grid Anno does not rotate to text symbol angle.

• NIM064320 - The result tag in locator style is not processed when used in score calculation context. This is needed to match hyphenated house 
numbers that have their hyphen stripped from the reference data.

• NIM064322 - Error geocoding an address that contains Z values with an ArcGIS 10 locator.

• NIM064329 - Grid Layout View: Configure layout is setting data frame extent to null if it had a fixed extent.

• NIM064332 - Make Grids and Graticules Layer: Tool calculates incorrect UTM Zone at equator and fails.

• NIM064333 - Make Grids and Graticules Layer: Tool is replacing set PCS in zipper grids with actual coordinate system value.

• NIM064330 - Import XML Workspace Document errors when you type into the input box.

• NIM064331 - Make Grids and Graticules Layer: Mask and buffer error with AOIs in southern hemisphere.

• NIM064423 - Report a proper error code and error description when packaging encounters an invalid layer.

• NIM064490 - Models exported to Python script should not have an importToolbox in the mobile toolbox.

• NIM064491 - Plan Directory needs to allow multi-select.

• NIM064487 - "UseByDefault" property on the network attribute object obtained from describing SDC network datasets returns incorrect values.

• NIM064489 - In the vehicle routing problem (VRP), relax NALocation validation for excluded orders.

• NIM064492 - In TopoLoad, unclosed parcels fail when source geodatabase is different.

• NIM064495 - Not able to import parcels with connection lines into an unjoined group.

• NIM064497 - For maps that contain view extents not present in the spatial reference's extent, ArcMap hangs or crashes when exporting to PDF with 
the Export Map Georeference Information checkbox turned on.

• NIM064493 - Parcel Explorer does not empty its contents after removing a fabric layer.

• NIM064494 - Need a better message when locking message appears.

• NIM064486 - Service Area solver does not properly accumulate negative weight cost values for accumulated attributes on lines features.

• NIM064431 - Using ArcSDE data, AddJoin with qualifiedFieldName = True followed by CopyFeatures is fully qualifying the Shape, Shape_Len and 
Shape_Area fields.  This does not happen with other geodatabase data sources.

• NIM064435 - Duplicating parcels in an unjoined group should create a new group.

• NIM064425 - When consolidating ERS rasters on UNIX / Linux, they consolidate successfully but the layer points to the original datasource.

• NIM064430 - There are problems exporting some distribution information and multiple processors associated with a process step lineage from 
ArcGIS to ISO 19139. There are problems importing many citation dates and some spatial reference properties to ArcGIS from ISO 19139.

• NIM064436 - Initial container does not display well when the containers are collapsed by a collapse rule.

• NIM064447 - Summary Statistics does not release memory when the tool completes.

• NIM064458 - Cartographic line symbology with a negative offset, when at a large scale, causes ArcMap and ArcCatalog to crash.

• NIM064443 - Extend Topology exception support in TopoLoader.

• NIM064444 - Loading unclosed parcels should create buffer geometry.



• NIM064726 - Composite locators leak  around 50 bytes per geocode.

• NIM064689 - Update popup stylesheets to display Chinese characters.

• NIM064730 - Even if valid licenses are available, license borrowing fails if a timed-out license is being stored.

• NIM064788 - Character replacement for apostrophes does not work.

• NIM064787 - Duplicate characters should not have too great an influence on the match score.

• NIM064652 - Update the Military Styles with missing APP6B symbols.

• NIM064651 - Crash on create Parcel Fabric.

• NIM064666 - in Calculate Field, have !shape.length@units! return geodesic distance when data is unprojected

• NIM064675 - General GML elements used to describe units of measure,times, points, and polygons in metadata are handled incorrectly when 
importing and exporting between ArcGIS metadata and the ISO 19139 format.

• NIM064668 - Raise a more helpful message when calling MapDocument.saveACopy on an already-open or read-only MXD.

• NIM064789 - Hyphens do no match blank spaces.

• NIM065725 - Web maps in the 1.2 Web map format (i.e. any Web maps created or modified on or after March 3, 2011) can't be opened in ArcGIS 
Desktop 10.0. Error "Could not open the specified file" is returned.

• NIM065544 - SAWLS fails to refresh count on activation request after correction.

• NIM065807 - Image Classification crashes with image services data when the service data is large.

• NIM064552 - Importing a populated toolbox fails.

• NIM064945 - Parcel fabric does not release ArcSDE connection after reconcile.

• NIM064877 - Using breakpoints and then saving the construction results in mangling.

• NIM064966 - The offline authorization for the License Manager needs to be modified so that it is only a one step process.

• NIM065087 - List of CHMs/LIfs/GPXML for 10.0 SP2  documentaion.

• NIM064990 - The first two links in the Help > About on Windows 7  do not work; the third works.

• NIM064579 - Improve guard logic to prevent partially populated GDB_Items row from being created by ArcGIS.

• NIM064585 - Create fabric does not recognize a version 10 geodatabase in SQLServer.

• NIM064570 - TableToNetCDF tool creates incorrect output.

• NIM064576 - Registering a Network Dataset as Versioned, fails to register the n_#_edgeweight and n_#_turnweight as versioned.

• NIM064591 - Cannot rebuild locators that are created with the General Style.

• NIM064595 - Make Item Description of a custom tool editable.

• NIM064586 - The Start Editing dialog is causing a GDI leak when there are datasets from multiple workspaces.

• NIM064587 - Cannot make edits to a feature class participating in a network dataset that has been built and does not support turns.

• NIM064567 - Cancelling out from the Save Report/Report Layout dialog does not return the application to the Viewer/Designer; it closes out the 
Reporting tools.

• NIM064561 - Observerpoint/Viewshed should ignore VCS if it does not exist on the input datasets for CURVATURE calculation.

• NIM064562 - IGeometryServer::Cut crashes in certain cases.

• NIM064553 - In feature templates for the unique values, specifically with shapefiles, many of the fields rendered may not be created correctly.

• NIM064554 - Prevent users from creating attachments in a geodatabase for a class owned by a different user.

• NIM064565 - Import Message disabled for two-way replicas

• NIM064566 - Loading or running a report from an .rlf with field sorting set to Descending resets the sort order to Ascending.

• NIM064563 - IGeometryServer:LabelPoint crashes in certain cases.

• NIM064564 - IGeometryServer::Buffer crashes in certain cases.

• NIM064639 - The Export to CAD tool does not write any entities out when true curves are used as input and written out to DGN files. These entities 
are not in Microstation.

• NIM064640 - URL linkages containing a # are not saved correctly in the item's metadata.

• NIM064636 - Supress these two dialogs when running arcpy.mapping scripts: 1) layer file login and 2) software expiration warnings.

• NIM064638 - Prevent setting textElement.text to an empty string.

• NIM064647 - Memory leak occurs with offset geometries.

• NIM064650 - Restoring stolen job lock.

• NIM064641 - Do not show Export or Validate buttons if the metadata style does not include default values for them in the Config file.

• NIM064643 - IGeometryServer::Offset causes memory leak.

• NIM064635 - In Metadata Editor, add the ability to increase the size of the text boxes that are used to provide the Summary, Usage, etc. If there is a 
long description in the Summary text box, the small working space requires scrolling back and forth.

• NIM064628 - Leading zero of the 4 digit code in ZIP+4 should not be stripped when using the ZIP+4 Range locator style.

• NIM064629 - Change upgrade status text for upgrades in which only the ArcSDE procedures and tables need updating.

• NIM064596 - <resource_logging> a certain SpatialJoin case leaks 100s of MB over 40 iterations.

• NIM064597 - Progressive increase in memory usage during multiple geoprocessing operations in the same ArcGIS session.

• NIM064632 - Allow 10.0 SP2 clients to connect to newer releases of the geodatabase.

• NIM064633 - MapDocument CoClass does not correctly save back to previous versions.

• NIM064630 - Information describing the domain of an attribute's value is not formatted correctly in the item's metadata.

• NIM064631 - Saving changes in metadata editor does not update metadata date stamps.



• NIM064445 - Optimize memory usage when when creating multiple server connections under load.

• NIM064442 - Improve stability when accessing secured ArcGIS Server services under load.

• NIM064451 - Memory leak with Internet Explorer 8 and out of the box ArcGIS Server Java Applications consuming a cached service.

• NIM064574 - Update Image Server ExportImage operation to honor the default mosaic rule when a mosaic rule is not set in the request.

• NIM064278 - In .NET REST, include "Cache-Control: max-age=0, must-revalidate" in Feature Service Query response header.

• NIM064277 - In Java REST, include "Cache-Control: max-age=0, must-revalidate" in Feature Service Query response header.

• NIM064359 - Do not print an invalid version number included in the request for an ArcMap/ArcGlobe/Image layer file (e.g., &v=93.1) when returning 
an error message in the HTML page.

• NIM064419 - In the KML created for generateKML latitude spelled as lantitude
resulting in bad LookAt in GoogleEarth

• NIM064360 - Do not print an invalid version number included in the request for an ArcMap/ArcGlobe/Image layer file (e.g., &v=93.1) when returning 
an error message in the HTML page.

• NIM062241 - WMS GetMap Request to an msd service instance with the SLD parameter enabled shows double labels.

• NIM061813 - SOM crashes when trying to reconnect to a previously disabled machine when the entire system is under high load.

• NIM062491 - While using ArcObjects Java API, IServerContext can not be serialized.

• NIM062739 - The "Get Token" URL link shown in the Services Directory login/logout page  and REST admin login/logout page should link to 
getToken.html file

• NIM062631 - Setting time parameter to null,null for export map/identify operation is not acknowledged when the timeslider is enabled on the Map 
document.

• NIM061804 - KML Popups from Optimized MapServices do not open when selecting features in KML clients.

• NIM058173 - A REST query and identify on the same envelope bring back different geometry for the same point feature when a transformation from 
1927 to 1984 is present in the map document.

• NIM051154 - Querying XY event layer with ArcGIS Extension for Google API does not generate correct output.

• NIM060043 - When a larger size image is requested with a higher dpi than the original map, which is cached at 96dpi, the image loses transparency 
and fills it with black color.

• NIM060944 - When a map service contains two data frames (one dynamic and one cached), exporting an image from the dynamic data frame does 
not work if the cache is set to use Cache-On-Demand

• NIM060113 - The WFS 1.1.0 takes wrong order (lat,lon) of coordinates in BBOX request parameters when optional 'crsuri' is missing.

• NIM063855 - Update Image Server exportImage operation in .NET REST to support background color.

• NIM063854 - Update Image Server exportImage operation in Java REST to support background color.

• NIM063927 - Update .NET REST to allow input recordset larger than 4 MB for batch geocoding operation using Geoprocessing Services.

• NIM064263 - Optimized MapServer draws labels from all features of a time-enabled-layer even when time is set. This only happens when the layer 
has null symbol.

• NIM064005 - Server logs are growing beyond limits set by <LogSize>  property.

• NIM063436 - Update .NET REST SOE handler to allow use of strings as resource identifiers in urls.

• NIM063084 - For ImageServices that are not time enabled, currently timeinfo is returned with a null timeExtent in Image Server resource. Do not 
return any timeinfo for such services.

• NIM062995 - Validation of an agsadmin user fails if that user belongs to another group that is part of the agsadmin group.

• NIM063147 - Under the German locale, ArcGIS Server Java incorrectly uses commas instead of decimals for the BBOX constructed in the WMS 
Capabilities documents.

• NIM063319 - "Reaspect" parameter doesn't work for MXD-based WMS.

• NIM063252 - .NET REST does not forward requestProperties as JSON object. Java REST sends an empty JSON object {} in this case.

ArcGIS Server (42)

• NIM060800 - In memory feature classes, the getCount method returns a value of zero on Linux platforms and a value of one on Windows XP. This 
problem is only reproducible when creating feature classes using an in-memory workspace.

• NIM061297 - Adding an IMapControlEvents2Adapter object as a listener twice to a MapBean object locks-up the application in 10.0.

• NIM061403 - ControlsAddDataCommand fails to connect to ArcGIS/WMS Servers using HTTP.

• NIM060630 - ArcEngine controls (ArcGIS 10.0 and Visual Studio 2008) should initialize gdi+ on their own.

• NIM053147 - Engine TOCControl layer drag and drop not functioning correctly.

• NIM058159 - Memory leak occurs when using the IDynamicDrawScreen.DrawScreenPolyline method.

• NIM058798 - Performance when loading/panning/zooming a globe control application using 3D map service layers is extremely poor.

• NIM064391 - Add the Common Controls 6.0 specification to all the controls and the Measure Tool.

• NIM064667 - Importing XML delta files results in a crash in some instances.

• NIM064728 - Find Route does not return localized driving directions when using AGOL routing services.

• NIM064343 - Custom Measure Tool that extends BaseTool fails to work properly.

• NIM061571 - Application created in C++ and Qt 3.3.8 crashes when trying to add data through custom Button.

• NIM062115 - Use of ArcObjects Java API leaks memory in the application.

• NIM062288 - ArcGIS Engine Java ControlsMapGoToCommand when using the Tab key freezes entire appplication.

ArcGIS Engine (14)

• NIM065915 - Extract package GP tool is not working in 10 SP2 build # 3200.



• NIM063503 - Transverse Mercator inverse (from xy to lat/lon) can hang when converting points that are outside the projection's area of use.

• NIM063120 - "Failed to paste shape or row not found" error when using ArcCatalog to copy and paste a feature class into ArcSDE for SQL Server if 
the "no count" parameter is on for the SQL Server instance.

• NIM063612 - Grant privileges to second user by owner on MV view to edit failed with error “ORA-01720: grant option does not exist for 
'SDE.STATE_LINEAGES'.

• NIM063530 - in Replication, export datachange message does not bring down changes.

• NIM062965 - ArcMap fails when doing concurrency editing between mv_views and and an ArcMap session.

• NIM062679 - Running sdesetup -o install on Oracle 11G R2 64bit Standard edition for ArcSDE fails with an error

• NIM062678 - ST_INTERSECTS query produces ORA-29903: error in executing ODCIIndexStart() routine.

• NIM062949 - Unique constraint violation encountered when editing a multi-version view in the DEFAULT version.

• NIM062876 - <DB2 ONLY> - Dataloading at 10.0 is slower than 9.3.

• NIM063617 - Query against a multi-version view on a named version or on a user-schema geodatabase default version returns an incorrect result.

• NIM063991 - <z/OS> - Creation of a global temporary table during a gdbrepair operation will fail with error - SQL0199N  'The use of the reserved 
word "WITH" following "" is not valid'.

• NIM063770 - Copy Raster hangs with 'out of memory' error when copying large rasters into a PostgreSQL geodatabase on Windows.

• NIM064006 - PostgreSQL:  Unable to upgrade with 'sdesetup -o upgrade' and with upgrade Python script on Linux 32-bit.

• NIM063997 - <DB2- 10.0 Final to 10.SP(x) ONLY>-  Upgrade from 10.0 Final to 10.0 Sp1 hangs in ArcCatalog when trying to recreate a stored 
procedure that is in use - 'sde_release_proc'.

• NIM060955 - Provide the ability to directly edit a multi-versioned view in the DEFAULT version.

• NIM061091 - A certain SQL query involving st_intersect uses much more memory and is much slower after ArcSDE 9.3.1 Service Pack 2 is applied.

• NIM059748 - Add CARDINALITY hint to SELECT statements using the TABLE (CAST (:numtab AS SDE.sdenumtab)) subquery to improve 
performance of queries

• NIM059541 - Select By Attributes does not return records with values containing a question mark preceded by a space within Oracle geodatabases.

• NIM059641 - Unable to display map services using map documents that use SDE data sources on RHEL5 x64 under the zh_CH locale.

• NIM062529 - Display issue with line feature classes within feature dataset after using migrate storage tool.

• NIM062540 - Cannot rebuild ST_Geometry spatial index in SQL when nls_numeric_characters is set to ',.'  as is the case for some European 
language NLS settings.

• NIM062511 - Using Oracle expdp to export sde schema will generate an error about st_spatial_index on gdb_items table if the database NLS 
settings are set to GERMAN and OS regional settings are also GERMAN and there is at least one feature classes stored with ST_GEOMETRY data 
type.

• NIM061828 - Support Lambert conformal conic definitions with only latitude of origin and scale factor parameters.

• NIM062082 - The Chinese code page is being read incorrectly by ArcSDE on a 64-bit RedHat Linux OS, which causes problems such as sdemon 
failing to start the service.

ArcSDE (29)

• NIM058723 - Enhancement: Please enhance the error message received when a user is unable to publish a service with mobile capabilities because 
a custom extent has not been defined.

ArcGIS Mobile (1)

• NIM061140 - After installing ArcGIS Server 9.3.1 Service Pack 2, it is not possible to open a second folder within Manage Services after opening one 
folder to view its services.

Java Manager (1)

• NIM059514 - When viewing a cached map service secured using Windows users and groups with the JavaScript viewer in the REST services 
directory, only some tiles are delivered.

• NIM061637 - IServerUserInfo.Name returns a null value when used in REST SOE.

• NIM063359 - Initial Extent is spelled "Intial" Extent on the map service REST page.

REST API (.Net) (3)

• NIM064593 - Nullable property of a field should be taken in to consideration when creating a default template in Feature Server.

• NIM064594 - When a new feature is added that violates a unique value constraint on a field, the editing operation still reports success.

• NIM064592 - Feature server should not allow NaN as a geometry input and should not return geometry with NaN in a JSON response.

• NIM064589 - Feature Server AppyEdits method only works if Adds/Deletes/Updates are passed as valid object types. If NULL is passed for any of 
these, it appears as though it was successful, but edits are not applied.

• NIM064590 - Feature Services should not publish and return an error message when data from two different versions are in the map.

• NIM064621 - Support Identify() function does not search for related records when it is not asked.

• NIM065055 - ETag match exception is not handled correctly for ExportImage requests in .NET REST.

• NIM065489 - The feature service should call refresh version when an edit is applied.

• NIM064781 - Tile handler requests for 3D tiles are no longer working.

• NIM064637 - Validation process for thread_count parameter on the Manage Map Server Cache Tiles should be moved to the Execution phase of the 
tool.

• NIM064642 - Update Image Server ExportImage/Identify operations in .NET REST to honor the default mosaic rule when a mosaic rule is not set in 
the request.



• NIM062808 - Mosaic to new raster results stripes of NoData when mosaic output location is outside a geodatabase.

• NIM062952 - The projection unit changes from Foot (9.3.1) to Foot_US (10.0).

• NIM063532 - The projection unit changes from Foot (9.3.1 SP2) to Meter (10.0 SP1).

• NIM061537 - NoData value of a 32-bit floating point raster is read incorrectly.

• NIM061728 - Exporting a 3- band raster does not allow Force RGB even when switching to stretched renderer.

• NIM062613 - Setting arcpy.env.pyramid = "PYRAMIDS" does not build pyramids as documented.

• NIM063867 - ArcMap/ArcCatalog will freeze and not respond if the mouse cursor is moved outside the ArcGIS application when adding an Applanix 
raster to mosaic data while it is filling radial distortion information.

• NIM064053 - ArcObjects code randomly fails and\or returns null while iterating through the rows of a large table.

• NIM064094 - Moving topology nodes which snap to other features is causing a crash that points to IntersectionPoints::XPoint.

• NIM063722 - Modification of Pixel Size for Camera Definition for Applanix data does not persist.

• NIM063792 - Cell size and extents of some TIFFs are read incorrectly and the image is misaligned.

• NIM063842 - In ArcCatalog nearest neighbor pyramids are created for TIFF images when bilinear or cubic is selected.

• NIM064648 - Setting a text background on SnapTips causes Graphics Device Interface (GDI) objects to leak.

• NIM058170 - When a globe document is added from the ‘Open Document’ tool in an ArcGIS Engine application based on the ‘GlobeControl 
Application’ template, the globe shakes/wobbles considerably while panning.

• NIM057871 - Cannot preview MrSID Generation 3 file in ArcGIS 10.

• NIM061221 - ArcGIS Engine 10.0 .NET :Metadata.synchronize does not work on dteds. This problem only occurs when using 10; it works fine in 
9.3.1 using 9.3.1 DTED data.

• NIM059266 - MrSIDs (MG2 and MG3) do not work and display an "Invalid Raster Dataset" error in ArcGIS 10, but work in ArcGIS 9.3.1.

• NIM060323 - Provide a sample for how the ‘ISchematicConnection.Object’ property is used.

• NIM060162 - Some TIFF images with YCbCr JPEG compression do not display properly.

• NIM059396 - When overviews are built, 1-bit raster displays with an inverted color ramp.

Other (20)

• NIM064755 - Make changes to support Unix/Linux remote startup using xinetd or a script without the need to rename sderemote to 'iomgr_inetd.'

• NIM064059 - When attempting to create a query layer with data in a DB2 z/OS database, an SE_NOT_IMPLEMENTED_YET error is returned.

• NIM065455 - Upgrade fails when creating GDB_ITEMS table due to unexpected WGS_1984 entry in ArcSDE spatial reference table.

• NIM064994 - Loading or querying certain Chinese characters in a UTF8 environment on Linux results in SES_iconv_open and 
U_STRING_NOT_TERMINATED_WARNING errors.

• NIM064866 - The buffer geoprocessing tool crashes for certain shapes.


